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Auto editing summary:

e Simple control using
Auto Smart FiX, Auto The simplest tools are almost always fully automatic with the user having

Color, Auto Levels,
Auto Contrast, Auto

Sharpen and Auto displayed in the new Fix panel on the right of the Organizer workspace.
Red Eye Fix These options provide a great place to start if you are new to digital

* Rotate left or right
options

e Manual cropping

¢ Changes applied

ADVANCED PHOTOSHOP ELEMENTS 6 FOR DIGITAL PHOTOGRAPHERS

n earlier editions of Photoshop Elements all editing and enhancement actions were centered

around the tools and features in the Full Edit workspace. More recently Elements has

provided the photographer with several different levels of editing to choose from. Photoshop
Elements 6 introduces a new option to this group, the Guided Edit, which combines both
instructions and tools in a single panel. All editing approaches have their own strengths and
challenges and in this chapter I will overview each option in turn. In addition I will introduce
the advanced concept of ‘non-destructive editing’ using some of Elements most powerful tools
and a couple of features that we sneakily borrow from Photoshop. So let’s get started!

The options can be grouped around five different approaches to the task:
e Automatic, e Guided edits,
* Semi-automatic, ¢ Non-destructive and

e Manual, e Photoshop assisted.

/

Automatic editing

little control over the final results. These are the types of color, contrast,
brightness and sharpness controls that are available in the Photo Browser
either via option in the Edit menu, from the right-click pop-up menu or

photography and want good results quickly and easily, but experienced

users will find the lack of control frustrating.

automatically @ @ @ oo Avtomatic
* New users start here -—gzgm
for good, quick
results
¢ Automatic control of: o
contrast, color, Right click
shadow and
highlight detail and Photo
sharpness. e Browser
workspace

The range of auto enhance options have been expanded for version 6 of Photoshop Elements
and now includes Auto Color, Auto Levels, Auto Contrast and Auto Sharpen options along with Auto Smart Fix and Auto
Red Eye Fix features found in the previous version. The features are grouped in the new Fix panel and include Rotate
buttons and a new Crop option.

Book resources at: www.adv-elements.com
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Auto Contrast is designed to correct images that are either
too contrasty (black and white) or too flat (dull and lifeless).
Unlike the Auto Levels feature, Auto Contrast ensures that the
brightest and darkest pixels in the picture (irrespective of their
colors) are converted to pure white and black. In doing so all
the tones in between are expanded or contracted to fit.
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Auto Color concentrates on correcting the color in the
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midtones of the picture and adjusting the contrast by
reassigning the brightest and darkest pixels to white and
black.

Auto Levels is similar to Auto Contrast in that it maps the
brightest and darkest parts of the image to white and black
but differs in that each individual color channel is treated
separately. In the process of mapping the tones (adjusting
the contrast) in the red, green and blue channels, dominant
color casts can be neutralized.

Auto Sharpen applies a set amount of sharpening to the
photo. Most photographers prefer to be able to adjust the
degree of sharpening that is applied to their images and
so would avoid using this auto feature in favor of a more

manual approach involving the Editor: Enhance > Adjust
Sharpness filter.

Sometimes such automatic fixes do not produce the results
that you expect. In these scenarios use the Undo (Edit >
Undo) command to reverse the changes and try one of the

manual correction tools detailed in the next section.

View Win

! Auto Smart Fix Alt+CEr+M
Auto Levels Shift+Ctri+L
Auto Contrast Alt+Shift+Ctri4+L
Auto Color Correction Shift+Ctri+B
Auto Sharpen
»  Auto Red Eye Fix Ctri+R
Adjust Smart Fix... Shift+Crri+M
Auto options also Adjust Lighting
he Fix Adjust Color
panel’s auto features Convert to Black and White...  Alt+Ctri+B (a) Original uncorrected image.
can also be found in the (b) After applying Auto Levels.
Enhance menu of the Unsharp Mask... (c) After applying Auto Contrast.
Full Edit or Quick Fix Adjust Sharpness... (d) After applying Auto Color Correction.

workspaces. (e) After Auto Color and Auto Sharpen

Book resources at: www.adv-elements.com
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Automating editing of several pictures at once

It’s true that shooting digital has meant that many photographers have saved the time that they
used to spend in the darkroom processing their images. The flip side to this coin is that now we while
away the hours in on-screen production instead. Surely with all the power of the modern computer
and flexibility of Elements there must be quicker ways to process files. Well yes there is!

5.04 Processing multiple files

Suitable for Elements - 6, 5.0, 4.0, 3.0 | Difficulty level - Basic
Related techniques — 5.05, 5.06

Photoshop Elements users are able to automate a variety of editing functions with the Process
Multiple Files feature located in the File menu of the Full Edit workspace. The feature is like a
dedicated batch processing tool that can name, size, enhance, label and save in a specific file format
a group of photos stored in a folder or selected via the file browser or Open Files.

The dialog’s options include:

® Leamn more about:

Source —Files to be processed can be stored
in a single folder, the files currently open in

Process Files From: Folder

the workspace, pictures in the Project Bin or source:
images multi-selected in the file browser.

Include All Subfolders
Destination:

Destination — Sets the location where
Browse... !v Shels

processed files will be saved. A |- Labels
‘Watermark

File naming — Options for naming or

File Naming

+ Bename Files
Custom Text:

renaming of selected files including a range

Document Name + 3 Digit Serial Number

Of preset naming styles. Example: MyFile001.gif Starting serialé: 1

. . . . Compatibility: Windows Mac 05 Unix
Image Size — Specify size and resolution

Image Size

changes after choosing the unit of measure G
to work with from the drop-down menu. widths

em Resolution: 150
i

. . Height: cm
Proportions can be constrained. o

. Constrain Proportions

File type — Select the file format that e

+ Conyert Files t0: | JPEG High Quaity

processed files will be saved or converted to.

Log errors that result from processing files

Quick Fix enhancement — Use the options
here to apply automatic enhancement of the
files being processed.

Add Labels — Add caption or file name
labels to each of the processed files. Also

e RN IR KRS £lements users can automate the

application of basic enhancement and editing features to a
group of files using the Process Multiple Files feature located in
the Full Edit workspace.

contains an option for watermarking the
pictures.

After setting the options for each of the
sections in the dialog press the OK button to
process the pictures.

Book resources at: www.adv-elements.com
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ADVANCED PHOTOSHOP ELEMENTS 6 FOR DIGITAL PHOTOGRAPHERS

5.05 Multi-selection editing

Suitable for Elements - 6, 5.0, 4.0, 3.0 | Difficulty level — Basic | Related techniques — 5.04, 5.06

Another method of applying automatic changes to several photos at once is to multi-select

photos in the Photo Browser workspace then choose an editing option from the right-click pop-

up menu or the new Fix panel. There are a multitude of options available using this approach,

all of which provide quick editing changes to the selected photos. For best results always apply

critical edits and enhancements manually, but multi-select edits are particularly useful if you

want to process a bunch of files quickly. The added bonus is that the edited versions of the

pictures are not saved over the original file, but rather they are kept in a Version Set, so that it is

always possible to extract the original file, or reverse the enhancement changes, if need be.

Keystrokes for fast edits of multi-selected photos

5.06 Bulk Red Eye fixing

Suitable for Elements - 6, 5.0, 4.0 | Difficulty level — Basic
Related techniques - 5.04, 5.05

As well as being able to apply the Auto Red Eye Fix feature to
individual photos this correction option is also available in
the Adobe Photo Downloader dialog. So now it is possible to
download pictures from your camera, or import them from a
folder, and at the same time be searching the images for red
eye and correcting it when it is present. This is a great time
saver if you regularly photograph with on-camera flash but
as always for the absolute best results apply the Red Eye Fix
yourself manually.

Book resources at: www.adv-elements.com

Auto enhance several files >>

The editing and enhancement
options located on the right-click
menu or the new Fix panel in the
Photo Browser workspace can be
just as easily applied to several
photos that have been multi-
selected as to a single picture.

This method is a quick and easy
means of making automatic changes
to a group of photos.

Get Phates fene Qohfaldess

“ [ Autamatically Fix Fied Eyes ™
Wﬁcks

INGLECESENES The Auto Red

Eye fix option is also available in
dialogs that are used to import or
download pictures onto your
computer. Selecting this option
instructs Elements to search and
correct any occurrence of red eye in
the photos you are loading into the
Organizer workspace.
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Semi-automatic editing

The second level of features sits in the middle ground between total user control and total
program control over the editing results. The tools in this group are primarily available in

the Quick Fix editor but also encompass some of the more automatic or easy-to-use controls
available in the Full Edit workspace. Move to these tools once you feel more confident with the
digital photography process as a whole (dlownloading, making some changes, saving and then
printing) and find yourself wanting to do more with your pictures. Again, for the advanced user
the tools listed here will provide a degree of frustration as the amount of control over the results

is still limited.

5.07 Using the Quick Fix Editor

Suitable for Elements - 6, 5.0, 4.0, 3.0 | Difficulty level - Basic
Related techniques — 5.08, 5.09

The Quick Fix Editor contains a reduced tool, feature set designed to
facilitate the fast application of the most frequent of all enhancement
activities undertaken by the digital photographer.

The Zoom, Hand, Crop and Red Eye Removal tools and the Quick
Selection Tool and Selection Brush are located in a small toolbar to the
left of the screen and are available for standard image editing changes;
the fixed Palette Bin, to the right, contains the necessary features to
alter and correct the lighting, color and sharpness of your pictures.
Rotate buttons are located at the bottom of the dialog.

One of the best aspects of the Elements 5.0 version of this editing
option is the fact that the user can choose to apply each image change
automatically, via the Auto button, or manually using the supplied
sliders. This approach provides both convenience and speed when
needed, with the option of a manual override for those difficult
editing tasks.

The adjustment features are arranged in a fashion that provides

a model enhancement workflow to follow — simply move from the

top to the bottom of the tools starting with smart fixing and red eye
correction, working through lighting and color alterations and, lastly,
applying sharpening.

There is no doubt that for making speedy adjustments of your favorite
images with the option of some override control, the Quick Fix editor
is a great place to start. And the best thing of all is you can see the
before and after results of your changes on screen via the zoomable
preview windows.

STHNENERERN
ONILId3 OL SAVMH1Vd

e Middle-level control
using the features in
the Quick Fix and
Full Edit workspaces

* Some changes
applied
automatically, others
via a user controlled
slider

* New users progress
here with experience
and understanding

e Control of: cropping,
rotation, contrast,
color, saturation,
hue, temperature,
tint, shadow and
highlight detail, red
eye, midtone
contrast and
sharpening.

Arewwns bunips ojne-was

Book resources at: www.adv-elements.com
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Smart Fix

f control

Red Eye Fix

Lighting control for
changes to levels,
contrast, shadows
and highlights

PATHWAYS TO EDITING
IN ELEMENTS

Color control for
changes to saturation,
hue, color
temperature and tint

Sharpening
control

The Quick Fix Editor >>

The Quick Fix editor
combines the major
automatic enhancing
tools with manual
override slider controls
and great before and
after preview pictures.

Zoom, Move, Crop, Red Eye Rotate image Befbre After
Removal, Magic Selection Brush buttons preview preview
and Selection Brush tools

5.08 Adjust Smart Fix

Suitable for Elements - 6, 5.0, 4.0, 3.0 | Difficulty level — Basic
Related techniques — 5.01, 5.03

The Adjust Smart Fix (Editor: Enhance > Adjust Smart Fix)
version of the Auto Smart Fix feature provides the same control

over color, shadow and highlight detail but with the addition of a
slider control that determines the strength of the enhancement
changes. Moving the slider from left to right will gradually
increase the amount of correction applied to your picture. This

approach provides much more control over the enhancement

i i ) process and is a preferable way to work with all but the most
The Adjust

Smart Fix option provides a slider general phOtOS.
control for the auto enhancement
effects applied by the feature.

The Auto button, also located in the dialog, automatically applies
a fix amount of 100% and provides a similar result to selecting

Enhance > Auto Smart Fix.

Book resources at: www.adv-elements.com
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Manual editing

The next approach to editing includes tools and features designed to give the user professional
control over their editing and enhancement tasks. Many of the features detailed here are very
similar to, and in some cases exactly the same as, those found in the Photoshop itself. These tools
provide the best quality changes available with Elements, but they do require a greater level of

STHNENERERN
ONILId3 OL SAVMH1Vd

understanding and knowledge to use effectively.

The extra editing and enhancement power of these tools comes at a cost of the user bearing all
responsibility for the end results. Whereas the automatic nature of many of the features found

in the other two groups means that bad results are rare, misusing or over-applying the tools
found here can actually make your picture worse. This shouldn’t stop you from venturing into
these waters, but it does mean that it is a good idea to apply these tools cautiously rather than
with a heavy hand. In fact once most users develop a good level of understanding and skill with
the manual tools and features in the Full Edit workspace they seldom return to using automatic
enhancement options, preferring to remain in complete control over the pixels in their pictures.

5.09 The Full Edit workspace

Suitable for Elements -6, 5.0, 4.0, 3.0, 2.0, 1.0 | Difficulty level — Basic . SOphIStlcated
Related techniques — 5.07 ContrOI U5|ng the

features in the Full

The Full Edit contains the features and tools used for the most
sophisticated of the three different editing pathways provided in Elements !
6. The groups of tools included in this workspace are designed to give the Edit Workspace
user professional control over all their editing and enhancement tasks. * Most ed iting

changes applied
manually via settings

Aewwins bunips jenuep|

— input by the user
] Ao Smart Fix AAC 4 * Great for complex
Auto Levels Shift-+CirHL L
Auto Contrast Alt+5hift+ClriL ed|t|ng and
Autn Color Correction Shift+Ctr+B un
Auto Sharpen Shadows/Highlights... enhancement tasks
7 Auto Red Eye Fix Chr+R i
] ¥ _ / Erightness/Contrast.., performed by more
Adjust Smart Fix,., Shift-+Ctrl+4 | Levels... i+l .
Adjust Lighting » experienced users
Adjust Color k|
Convert to Black and White...  Ak+CtrHE R emave Color Cast... * The most control of
Urisharp Mask. .. ' Adjust HuefSaturation,.,  Cerl4+-U a" the major edltlng
Adjust Sharpness. .. Remove Color Shift+Ckrl+LU .
. replace Colar, . and enhanang Of
Adjust Color Curves. ., your- dlgltal
Adjust Color For Skin Tone. ..
The manual versions of Defringe Laver... phOtographS-
many automatic or semi-automatic Color Yariakions. ..

enhancement features are located in the
lower part of the Enhance menu.

Book resources at: www.adv-elements.com
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Auto Levels

Auto Contrast

Auto Smart Fix

ADVANCED PHOTOSHOP ELEMENTS 6 FOR DIGITAL PHOTOGRAPHERS

As well as providing manual versions of all the automatic enhancement options that we have
looked at so far, the Full Edit workspace also includes tools that enable the user to isolate where
and how the editing changes are applied to photos. For this reason most advanced techniques
detailed in the ensuing chapters of this book make use of the extensive tool and feature set
provided in this Editor workspace.

Toolbar Menu bar Options bar Jump to
Organizer

o Task Pane options
« Edit modes

Palettes in the
Task Pane

Image displayed
in workspace

Floating palette
displayed
in workspace

Open images shown
in the Project Bin

Auto/manual feature equivalents RGEIIIEETES Advanced editing and

enhancement techniques are generally applied
in the Full Edit workspace.

Levels or Shadows/Highlights or Brightness/Contrast
or Adjust Color Curves

Levels or Shadows/Highlights or Brightness/Contrast
or Adjust Color Curves

Levels or Shadows/Highlights or Brightness/Contrast Manual pathway choices >> [zslelteXlslele}
or Adjust Color Curves together with Elements provides manual alternatives for all
Remove Color Cast or Color Variations or Adjust Color For Skin Tones its automatic and semi-automatic editing

options. This table summarizes the specific
manual features that can be used as
alternatives.

Book resources at: www.adv-elements.com
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New editing options in Photoshop Elements 6

The Guided Edit workspace is new for Photoshop Elements 6 and combines the step-by-step
instructions that used to be found in the How To feature with the direct enhancement control of the
Quick Fix edit space.

As part of the interface changes in Photoshop Elements 6, the guys at Adobe have grouped features,
tools and options into several task headings. The Task Pane and the associated headings are
displayed on the right of the Element’s workspaces with different options available in each. In the
Edit workspace these include Edit, Create and Share, where as in the Organizer the choices include
Organize, Fix, Create and Share. With all the management, editing, enhancement, and production
options now available in Elements the inclusion of these task based headings helps the user navigate
through the various phases of photographic workflow.

Edit task
" pane button

Three edit options >>
Along with a new interface
I:E QU ick EZ the Adobe engineers have

created a third editing
workspace to help users
with their enhancement
activities.

F

Full Edit Quick Fix Guided Edit
workspace workspace workspace

Nowhere are these changes more evident than in the Edit workspace where Elements users now
have the luxury of three different ways of conducting their enhancement activities. Once you

have selected the Edit heading you can then choose between Full Edit, Quick Fix and Guided Edit
workspaces. We have already looked at the Full Edit and Quick Fix workspaces so let’s now turn our
attention to the newly created Guided Edit option.

5.10 Guided Edits

Suitable for Elements — 6 | Difficulty level — Basic

Selecting the Guided tab from the Edit task pane displays a list of the tutorials that ship with
Elements. Clicking a tutorial heading will reveal subheadings for specific topics. Selecting a heading
topic will display a set of instructions together with associated buttons and controls. For instance,
in the example on the next page, two Rotate buttons (rotate left and rotate right) are displayed in the
panel. Clicking either of these buttons will perform the same action as selecting the same options
from the Image > Rotate menu.

Book resources at: www.adv-elements.com
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Guided edit is best
used for learning
how to use new tools
and techniques or,
as is the case with
the new Photomerge
Faces and Group
Shot options, as a
way to step through
complex techniques.

The Guided
Activities > Guide
for Editing a Photo
entry contains a
collection of guided
edits that are useful
when correcting
images. These
include crop, lighten,
darken, touch up

and sharpen.

Guided

[’;f Quick

# Ful

What would you like to do?

w Basic Photo Edits
Crop Photo
Rotate and/or Straighten Photc
sharpen P
# Lighting and Exposure
Lighten or Darken
Brightness and Contrast

w Color Correction

Correct 5kin Tone
+ Guided Activities

Touch Up Scratches, Blemishes or Tear
Marks

Guide for Editing a Photo

= Photomerge

Z raii [T ouick Guided

Rotate and/or Straighten
To Rotate a Photo:

nicon below to rotate the image
ft or right:

Tao Straighten a Photo:

en tool be hen draw
im vill rotate

When rotating or straightening:

& Maintain Irr

N canvas

Cancel

[EECNRETR The Guided edit workspace combines step-by-step instruction with

embedded enhancement or edit controls.

Non Destructive editing, the professional’s choice

Though not strictly an editing mode in itself, the idea of making changes to your images in a non-

destructive fashion is key to all professional workflows. For this reason I feel that it is appropriate

to introduce the idea here. When digital photography was in its infancy, all changes made to the

photo were applied directly to the original pixels captured by the camera or scanner. At the time, the

abilities of the software and hardware allowed frustratingly few alternatives to this destructive way

of working.

For me, as a photographer who trained when film was king, I found the idea of changing my

captured image rather distressing, as I would never have altered, cut, or intentionally marked my

negatives, so why should I have to work this way when opting for a digital workflow. This would

lead me to make countless copies of my original images to ensure that I had at least one copy of the

primary capture file to refer to at all times.

Book resources at: www.adv-elements.com
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Thankfully times have changed and digital photography is now well out of ‘short trousers’ and
software and hardware has developed to a stage where many of the editing activities we regularly
carry out in Photoshop Elements can be executed non-destructively, that is, without altering the

pixels of the captured file.

Throughout the rest of the text I will use non-destructive editing and enhancement techniques
where ever possible, but to get you up to speed, here I introduce a selection of tools, techniques and
features that can be employed to enhance your images non-destructively.

5.11 Adjustment Layers

Suitable for Elements - 6, 5.0, 4.0, 3.0, 2.0, 1.0 | Difficulty level — Basic

These special layers alter the look of the layers that are arranged
below them in the layers stack. They act as a filter through which the
lower layers are viewed. You can use adjustment layers to perform
many of the enhancement tasks that you would normally apply
directly to an image layer without changing the image itself. When
you choose to use an Adjustment Layer rather than applying the
enhancement change directly to the image you are choosing to work
non-destructively.

Creating an adjustment layer adds a new entry to the layers palette
just above the active layer. The adjustment layer entry contains two
thumbnails — the Layer Thumbnail on the left and the Layer Mask
thumbnail on the right. Double clicking the Layer Thumbnail will
display the adjustment layer’s dialog. For instance, in the case of a
Levels adjustment layer, double clicking the thumbnail will display
the Levels dialog. This provides the user with the ability to make
adjustments to existing settings, or even rest the dialog, at any time.
The Layer Mask is used to customize where and how the adjustment
layer’s changes are applied. See Technique 5.14 for more details.

Elements contains eight different types of adjustment layers which

are grouped together with the fill layers under the Create Adjustment
Layer button in the Layers palette. The same options can also be found
in the Layer > New Adjustment Layer menu. They are:

Levels — Adjusts the tones in the picture.
Brightness/Contrast — Lightens, darkens and controls contrast.

Hue/Saturation — Changes the color and strength of color in
photos.

Gradient Map — Changes the photo so that all the tones are
mapped to the values of a selected gradient.

STHNENERERN
ONILId3 OL SAVMH1Vd

Solid Color—
Gradient_
Pattern...

Levels_
Brightness/Contras

Hue/Saturation_
Gradient Map_
Photo Filter_

Invert
Threshold_
Posterize_

Adjustment Layers >> Faslel{eNgle]o]

Elements contains eight different
adjustment layers.

Adjustments applied downwards >>

Adjustment layers alter the look of
the image layers that are positioned
below them in the layers palette.

Book resources at: www.adv-elements.com
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ADVANCED PHOTOSHOP ELEMENTS 6 FOR DIGITAL PHOTOGRAPHERS

Photo Filter — Reproduces the color changes of traditional photo filters.
Invert — Reverses all the tones in a picture, producing a negative effect.
Threshold — Converts the picture to pure black and white with no grays present at all.

Posterize — Reduces the total number of colors in a picture and creates a flat paint (or poster)-
like effect.

Placing an adjustment layer at the top of a stack of layers will ensure that the editing changes will be
applied to the content of all the layers beneath. If instead of changing all the lower layers you want
to restrict the effects of the adjustment layer to a single layer then after selecting the adjustment
layer, pick the Group with Previous option from the Layer menu. This will indent the adjustment
layer in the palette and, more importantly, ‘group’ the adjustment with the layer immediately below
it. This technique is an important one as it changes the way that adjustment layers work and allows
their non-destructive editing powers to be applied to individual image layers only.

Gradient Map adjustment layer Gradient Map adjustment layer grouped with
being applied to both image Layer 1 so that the convert to gray change only
layers occurs in one layer only

RS RN RNEICAEYE®Sd 70 /ink the changes made via an adjustment layer to a single layer
only, make sure that the adjustment layer is directly above the image layer to be changed and then with the

adjustment layer active, choose Layer > Group with Previous or Ctrl G.
Pro Tip: Alt click on the border between a layer and the one below it to Group With Previous.

5.12 ‘All Layers’ tool options

Suitable for Elements - 6, 5.0, 4.0, 3.0, 2.0, 1.0 | Difficulty level — Basic

Removing dust and scratches is a regular correction activity for digital photographers, irrespective
of if they are working on scanned historical photos, or recently captured portraits, where the client
wants slight skin blemishes disguised. These changes are often performed with Elements’ features
such as the Clone Stamp tool, Spot Healing and Healing Brushes on the main or background layer.
Working this way changes the original pixels forever. A non-destructive work around that provides
the same results, makes use of the ‘All Layers’ options of these tools to keep the changes in a separate
retouching layer that sits above the background.

Book resources at: www.adv-elements.com
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ADVANCED PHOTOSHOP ELEMENTS 6 FOR DIGITAL PHOTOGRAPHERS

grayscale image to simulate the look of a hand colored photo of old. You may first think that the task
is a simple one, select the color, choose the Brush tool and then paint over the grayscale background
layer. Do this and you will get a paint stroke of solid color, that obscures all the detail of the original
image. Not the look that we are wanting! However, if you change the Brush’s Blend Mode (using

the drop-down menu in the tool’s option bar) to Color then the tool magically applies color in direct
proportion as tone of the background image. All detail is retained in the underlying image, but this

detail is colored the hue of the foreground swatch. This is the magic of the Color Blend Mode.

Blend Modes in action >> 5%

painting into a separate layer whose
Blend Mode has been changed to
Color you have the ability to tint the
grayscale image while still retaining
the original capture in the
background layer.

Note: Keep in mind that the grayscale
image needs to be in RGB Color mode
to be tintable.

That said, in applying the coloring directly to the background layer we are destructively altering
the primary pixels. So let’s rework the technique so that it still uses the Blend Mode but protects the
original image. Start by creating a new layer to house the color changes. Next change the Blend
Mode of the layer to Color. Select the foreground color and then the Brush tool. Make sure that the
Blend Mode of the Brush is back to the default setting (Normal). With the new color changes layer
selected, paint over the image. Notice that the same coloring effect is produced but this time the
Blend Mode change is applied to the layer not the Brush.

5.14 Layer Masking

Suitable for Elements - 6, 5.0, 4.0, 3.0, 2.0, 1.0 | Difficulty level — Basic

As we have already seen each time you add a fill or adjustment layer to an image two thumbnails
are created in the Layers palette. The one on the left controls the settings for the adjustment layer.
The thumbnail on the right represents the layer’s mask that controls how the adjustment is applied

to the picture.

The mask is a grayscale image. When it’s colored white no part of the adjustment layer’s effects are
masked or held back from the picture below. The full changes are applied to the image. Conversely if
the mask thumbnail is totally black then none of the layer’s effects are applied to the picture. Shades
of gray equate to various levels of transparency. In this way, the enhancement changes produced
via an adjustment, or fill layer, can be selectively applied, or merged, with the layers beneath by
painting (in black and white and gray) onto the layer mask.

Book resources at: www.adv-elements.com
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Modifying the mask associated with adjustment layers provides the option to customize where the
effects of the layer are applied to the image layer. Using varying levels of gray will also change the strength of the
enhancement effect. A darker gray will produce less noticeable changes whereas a light gray will allow more of the
adjustment layer’s effects to be seen.

By default the layer mask is set to white so that the adjustment effect is fully applied. To customize
the application of the effect, click onto the Layer Mask thumbnail (so that there is a second line
border surround in the thumbnail), select the Brush tool and choose black, white or gray as the
foreground color. Now paint over the surface of the image. Notice that the adjustment layer effect
isreduced or eliminated in the areas where you paint with gray or black. Also notice that the mask
thumbnail now displays the painted strokes. It is also worth noting that preselecting an area before
creating the adjustment layer will result in a Mask the shape and size of the selection.

Many professionals use masks on a regular basis to help customize the application of adjustment
layer changes and also for governing how the picture parts in separate image layers interact.
Though Photoshop Elements doesn’t contain all the masking power that its bigger brother
Photoshop does, customizing adjustment layers is no problem and, with a simple ‘work around’ (see
Technique 5.12), it is also possible to provide more masking functionality than is generally available
to the Elements user.

5.15 Duplicate layers

Suitable for Elements -6, 5.0, 4.0, 3.0, 2.0, 1.0 | Difficulty level — Basic

In situations where none of the above techniques can be used to edit non-destructively it will be
necessary to use other means to preserve the integrity of the original file. A clear example of this is
when it comes time to add some sharpening to your photos. Now by design, applying a sharpening
filter will pretty much change all the pixels in your photo in order to increase the clarity of the
picture, which makes the action very destructive and one that should be avoided. So what other
route can we take to provide the same results?

Well the simplest way is to duplicate the image layer, and then apply the sharpening filter to the
copy, rather than the original layer. This way the primary pixels (in the original image layer) are
Book resources at: www.adv-elements.com
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Sharpening Copy

Hue/Saturation 2

When there is no other option than apply editing changes directly to the image layer then
the best way to ensure that your original pixels are protected is to duplicate the image layer and execute the
changes on the copy (a). With multi-layer documents use the Copy Merge command to duplicate the contents of all
layers first before applying the editing changes to the merge layer (b).

protected and displaying the sharpened result is a simple matter of ensuring that it resides at the top
of the layer stack. Alternatively the original can be hidden from view (click the ‘eye’ icon on the left
of the layer entry).

In the case of a document that contains multiple image layers or a combination of image and
adjustment layers some photographers would merge all the image layers before copying the
resultant layer and applying the sharpen filter. The act of merging means that you will lose the
ability to change the settings in the adjustment layers or edit any of the image layers independently.
So forget the Layer > Merge Layers command, instead select the whole document using the Select

> Select All command and then copy the contents of all the layers to memory by choosing the Copy
Merged option from the Edit menu. Next select the uppermost layer in the layer stack and select Edit
> Paste. This action inserts a new layer at the top of the stack that is the combination of all the layers
in the document. This layer can then be filtered without fear of damaging the original photo.

Secret Pro Tip: Instead of doing the select all, copy merged, paste to top of stack steps, pros
simply add a new empty layer at the top of the stack and then do Shift-Alt-Control + E which is a
undocumented Stamp Visible command that unfortunately has no menu equivalent.

Book resources at: www.adv-elements.com
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Giving Elements a helping hand

It is true that Photoshop Elements contains a dazzling array of editing and enhancement tools. In
fact, many would say that if you can’t find a tool to perform the changes you desire, then you are
not really trying. But as we have seen, just having the right tool to hand is not the whole story, it
is also important to ensure that you are able to use the tools in a way that preserves the pixels first
captured, and produces the best quality enhancements possible. This often means using the tools
we have in ways that perhaps were not envisaged when the features were first designed. The next
few techniques extend the editing abilities of Photoshop Elements beyond the standard workflow
approaches advocated in most texts. These options may not need to be used with every photo, but
they will certainly come in handy with specific enhancement tasks and will become an important

technique in your editing kit bag.

e T AR AR Users can add to the functionality of Elements by opening Photoshop
documents (a) containing Photoshop only adjustment layers (e.g. Curves, Selective Color, Black and White and
Color Balance) and then dragging these layers to their Element documents (b). The adjustment layer’s
enhancements will be applied to the document, but the settings for these layers can not be altered in Elements.

5.16 Borrowing Photoshop features
Suitable for Elements - 6, 5.0, 4.0, 3.0, 2.0, 1.0 | Difficulty level — Basic

Because of the professional nature of Photoshop, it contains a range of high level features and tools
that are not available in Elements. This said, both Photoshop and Elements contain a range of tools
and features and technology in common and much of the nuts and bolts that sit behind the scenes
are shared by both programs. This cross over leads to an interesting situation where some features
that are Photoshop only can be borrow to be used, in a limited way, in Elements.

We have been talking about the importance of Adjustment Layers as a way of non-destructive
enhancing and, as you would expect, Photoshop contains more adjustment layer options than
Elements. Of interest to us particularly are the Curves, Color Balance, Selective Color and the new
Black and White adjustment layers. Though these features can't be invoked or Adjusted in Elements
a Photoshop document containing the layers can be opened in the program. The Adjustment layers

Book resources at: www.adv-elements.com
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can be seen as separate entries in the layers palette, but for the most part, the settings can’t be
adjusted, Black and White is an exception, but more on this later. When this scenario is coupled with
the fact that Photoshop adjustment layers can be dragged from one document to another, users end
up with the ability to apply non Elements based adjustment layers to Elements documents. Cool!

In practice, I created several documents in Photoshop containing Adjustment Layers with a variety
of settings, but no image data. I then open these files in Elements and drag the required adjustment
layer from the Photoshop document to the Elements file and hey presto, the enhancement is applied.
Now that is fine for me, as I have both Photoshop and Elements on my machine, but I know that
most readers do not have this luxury, so for this reason I have created several different Photoshop
documents that are available from the book’s website that you can use for your own projects.
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The book’s website contains several documents created in Photoshop that can be
used to donate Photoshop only adjustment layers to your Elements document.

(a) Photoshop-Selective-Color.psd

(b) Photoshop-Convert-to-gray.psd

(c)Photoshop-Curves.psd

(d) Photoshop-Split-Tones.psd

Book resources at: www.adv-elements.com
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Photoshop donor documents

The book’s website contains four key Photoshop donor documents (the files containing adjustment
layers which can be dragged to Elements documents) designed to be used for specific enhancement
activities. Each document includes multiple layers for a single adjustment feature. The settings for
each layer differ providing a bunch of preset enhancement options that can be applied to Elements
documents by simply dragging and dropping the layer to the Elements files. The donor documents
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include:

Photoshop-Selective-Color.psd — For boosting or reducing specific colors using the Selective
Color Adjustment layer.

Photoshop-Convert-to-Gray.psd — Monochrome conversions using the Black and White

feature.
Photoshop-Curves.psd — Curves based adjustment of the tones in your photos.

Photoshop-Split-Tones.psd — Sophisticated split toning effects using Photoshop’s Color
Balance adjustment layer to separately tone highlights and shadows.

5.17 Advanced layer masks
Suitable for Elements - 6, 5.0, 4.0, 3.0, 2.0, 1.0 | Difficulty level — Basic

Along with extra adjustment layers Photoshop also contains advanced masking options that are
not available in Elements. We have already see how it is possible to use the masks associated with
Adjustment Layers to customize where the layer’s effects are applied, well, Photoshop allows users to

Though not designed for this purpose it is possible to use the Layer Masks associated with
adjustment layers to mask image layers. In the example above the sky from the upper image layer is HomeSite with
the foreground detail from the layer below using the layer mask in the Levels adjustment layer. For this to occur
the adjustment layer needs to be created with no settings and then the upper image layer is Grouped with the
adjustment layer.

Book resources at: www.adv-elements.com
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use masks with image layers to provide the same level of customization when montaging. When a
mask is attached to an image layer, it can be used to adjust which parts of the upper layer are visible,
and which parts are hidden from view allowing the contents of the layer beneath to show through.
This is a very handy function as it is provides non-destructive montage abilities. Elements users can
access such masking abilities by highjacking the mask associated with an adjustment layer and use
it with an image layer.

The process involves adding an adjustment layer, with no settings applied, to the layers stack in
between the two image layers to be montaged. Next the upper image layer is grouped with the
no-settings adjustment layer. This action essentially links the image layer with the mask of the
adjustment layer. As the mask by default is white, the upper image layer is displayed in full, but paint
onto the layer mask with a black (or gray) brush and details of the lower layer will be revealed. By
using black, white and gray paint strokes on the mask it is possible to non-destructively mix the
contents of the two image layers. Look for examples of this technique throughout the next chapters.
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